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Version 8.9.6.10
Check list with required upgrade steps for 8.9.6.10:
 Make an export of the user V8LIVE.
 Make sure, that the database has been updated to the latest officially released version 8.9.6.4.
Run all the update scripts needed for this new version.
 Upgrading from 8.9.6.4:
-> 8_9_6_4_to_8_9_6_10#0.sql
-> 8_9_6_4_to_8_9_6_10#1.sql
-> 8_9_6_4_to_8_9_6_10#2.sql
Please note, the files 8_9_6_4_to_8_9_6_10#1.sql and -> 8_9_6_4_to_8_9_6_10#2.sql are update
scripts containing all changed views since 8.9.6.4. Executing 01_allviews.sql is not required in case of
updating from 8.9.6.4 only.
 Run the following statements, connected to Oracle as SYSDBA (these statements are also part of
the script 10_runasSYSDBA.sql - however, they are already required to avoid possible compilation
errors when creating all views and procedures). The variable SCHEMANAME needs to be replaced with
the name of the live user (usually V8LIVE):
CREATE OR REPLACE view sys.x_$ksppi as select * from SYS.X$KSPPI;
CREATE OR REPLACE view sys.x_$ksppsv as select * from sys.X$ksppsv;
GRANT connect to SCHEMANAME;
GRANT create session to SCHEMANAME;
GRANT create table to SCHEMANAME;
GRANT create type to SCHEMANAME;
GRANT create procedure to SCHEMANAME;
GRANT create view to SCHEMANAME;
GRANT create trigger to SCHEMANAME;
GRANT create sequence to SCHEMANAME;
GRANT create materialized view to SCHEMANAME;
GRANT select on v_$session to SCHEMANAME;
GRANT select on gv_$session to SCHEMANAME;
GRANT select on v_$database to SCHEMANAME;
GRANT select on dba_indexes to SCHEMANAME;
GRANT select on dba_tables to SCHEMANAME;
GRANT select on dba_users to SCHEMANAME;
GRANT select on dba_tab_columns to SCHEMANAME;
GRANT select on dba_ind_columns to SCHEMANAME;
GRANT select on dba_ind_expressions to SCHEMANAME;
GRANT select on v_$sess_io to SCHEMANAME;
GRANT select on v_$statname to SCHEMANAME;
GRANT select on v_$sql to SCHEMANAME;
GRANT select on v_$sysstat to SCHEMANAME;
GRANT select on v_$parameter to SCHEMANAME;
GRANT select on v_$instance to SCHEMANAME;
GRANT select on dba_free_space to SCHEMANAME;
GRANT select on dba_data_files to SCHEMANAME;
GRANT select on v_$log to SCHEMANAME;
GRANT select on v_$tablespace to SCHEMANAME;
GRANT select on sys.x_$ksppi to SCHEMANAME;
GRANT select on sys.x_$ksppsv to SCHEMANAME;
GRANT select on dba_rsrc_plan_directives to SCHEMANAME;
GRANT execute on dbms_crypto to SCHEMANAME;
GRANT execute on dbms_snapshot_utl to SCHEMANAME;
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GRANT
GRANT
GRANT
GRANT

create any table to SCHEMANAME;
select on dba_temp_files to SCHEMANAME;
select on dba_tablespaces to SCHEMANAME;
select on gv_$sort_segment to SCHEMANAME;

 After the update, please run the following scripts:
-> 01_allviews.sql
-> 02_allprocs.sql
-> 03_generated.sql
-> 04_autoindexes.sql
-> 05_200index.sql
-> 06_comments.sql
-> 07_afterVersionUpdate.sql
-> 08_gatherstatisticsforall.sql.
 Run the statements in the script 10_runasSYSDBA.sql by following the instructions as
described in the file.
 Use latest register.bat for new installations or minregister.bat for updates, both are provided with
the new executables and Dll's.
 Update existing VerCtrl.ini with new Dll's, Html's and Help Files or use latest one from FTP.
 In order to be compliant with Oracle policies the user password encryption in Suite8 has
been enhanced to use Oracle approved crypto algorithm. This requires all existing
passwords to be converted to the new hashing scheme, which is performed automatically
when starting version 8.9.6.0 or higher for the first time. It is strongly recommended to
make a back-up of the table XCED prior to upgrading to 8.9.6.x version in case a
downgrade will be required at a later stage.
License Changes and new Feature List
 New License Handling: All licenses in Suite8 have been adapted to the new licenses as
available on the Oracle Global Price list. Also license naming has been modified and SKU
numbers (former Part numbers) added for better identification/
comparison). All this is reflected in the sub license screen of Suite8. Some of the old
licenses have been removed and turned into features.
There are now 5 main licenses:
- Profession Edition
- Resort Edition
- Small Business Edition
- Conference and Catering Base (former CCM Only)
- Central Head Office (former Master flag)
The Number of available features in total: 102
- Profession Edition: all features can be enabled
- Resort Edition: max. 30 features can be enabled
- Small Business Edition: max 18 features can be enabled
For more details please see Release Notes of version 8.9.6.3 -> TT 24919.
 Install Shield: New installations will not create another user or add/change Leisure
tables anymore. From now on all Leisure data will be provided with the Install Shield and
will be stored in the same Oracle user (e.g. V8Live).
For more details and the please see Release Notes of version 8.9.6.3 -> TT 24985.
IFC 8.9.6.10
With Suite8 Version 8.9.6.10 it is required to install IFC8.9.6.10. For IFC8.9.6.10 it is
required to execute the IFC8 install wizard on the PMS workstations for the new
IFC8COmEx.dll to be installed and registered once. As a prerequisite for this new Dll .NET
4.0 is required. Please do not uninstall the existing IFCbusi installation!
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 Run Sequence Fix (Suite8 -> Setup -> Miscellaneous -> System Maintenance -> Database ->
Sequence Fix).
 Execute Primary key existence check (Suite8 -> Setup -> Miscellaneous -> System Maintenance ->
Miscellaneous -> System Check -> Database -> Primary key existence) and make sure no primary
keys are missing (except for WLNR, WNEB and STAB).
 Update Mailing (Suite8 -> Setup -> Miscellaneous -> Updates -> Mailing Update -> import
mailing.sql provided with this release)
 Update Translation (Suite8 -> Setup -> Miscellaneous -> Updates -> Translation -> Import
Translation Manually -> import translation file provided by local office)
 Please note that updating an existing Online Interface installation requires to first uninstall and
then to reinstall the interface by using the new Online Interface Install Shield shipped with this
release.
 The tray icon of the Fidelio Server is not visible anymore when running as a service on a Windows
2008 server. This is due to changes in the operating system, however a workaround is provided,
please refer to the Help File->How To->Fidelio Server->Fidelio Server->Installing Fidelio Server as a
Windows Service on a Windows 2008 Server.
 With 8.9.6.0 new functionality has been implemented to configure and manage FTP
accounts in Suite8, similar to common FTP clients. Therefore it is essential to review FTP
connection settings in applicable functions like Online Application Translation Import or
Scheduled Task File Upload.
 Check these release notes for new features/changes in Suite8.
 Please refer to TT 5 for an overview of all new user rights.
 Check which version of Oracle is used at the moment:
Oracle 11g Release 2 (11.2.0.3 or 11.2.0.4 - with latest Oracle Patch) for the database installation
(64bit) and client installation (32bit) OR Oracle 12c Release 1 (12.1.0.1 or 12.1.0.2 - with latest
Oracle Patch) for the database installation (64bit) and client installation (32bit) has to be used.
Please note, it is imperatively required to install Oracle 11g Release 2 with the parameter setting
'compatible=10.2.0.4'. Please refer to the latest install shield 8.9.5.3.
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S8 Accounts Receivable
Accounts Receivable
Issues fixed
23616

TT 23616 Accounts->Postings->Compressed postings: Speed when editing compressed
entries has been increased.
95449
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S8 Cashiering
Accounts Receivable
Issues fixed
24280

TT 24280 Thai Tax Handling & Accounts Receivable: when a posting has been checked
out as 'City Ledger' and payment has been cancelled afterwards, the city ledger
payment was still available in Accounts Receivable under Transactions->Holding Area.
From this version on it will not be displayed anymore.
98044

Cashiering
New Functionality/Feature
25291

TT 25291 Cashiering->Posting with Luxury Tax Handling enabled: Splitting Luxury Tax
amount of a reservation with no room charge resulted in wrong amount postings. This
has been fixed.
102083

Issues fixed
24279

24839

24846

25168

TT 24279 Posting & Thai Tax Handling: the error 'Cannot post Credit Note without
available tax invoices to reference' came up when the city ledger department code has
been set up with 'Generate Thai VAT #' enabled in configuration, a posting has been
made with an interim bill to city ledger and then a negative posting has been made.
This has been fixed.
98043
TT 24839 Cashiering->Billing->Payment & Global Settings->Billing3 tab->'Store
Payment Receipts in Billing History' is enabled & Country Specific Tab1->'Enhanced
Deposit Handling' is disabled: The payment pre arrival guest/deposit was not shown on
the final invoice and the balance was incorrect. For example: create a reservation but
don't check in, post a payment of 100,00 and print a receipt, check in and post room
charge of 150,00, create an interim folio and pay remaining 50,00=> Invoice does not
show the original deposit payment and an open balance of 100,00.
100361
TT24846 Cashiering with Legal Requirements for Thailand->Abbreviated Form: The
display of Thai Tax number has been changed to: DDMMYY-[Payment Type][Workstation][Invoice number from cycle per workstation]. In addition the Credit Note
Payment Type is available again.
TT 25168 Billing / Posting: Balance was not correct when splitting a rate code posting
having an internal package split linked. This has been fixed with version 8.9.6.4.
101588
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S8 CCM
Booking Master
Issues fixed
24955

TT 24955 Booking Master: An error for already linked profile role came up when trying
to link an individual reservation to a booking where both have different
companies/travel agents linked. This has been fixed. The linked profiles of the booking
will only be linked to the reservation if there is the profile role not linked already.
100906

Miscellaneous
Issues fixed
25205

TT 25205 Conference Diary: Shareable events have been displayed in HTML although
they were cancelled. This has been fixed.
101568
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S8 CRM
Online Interface Best Western
Issues fixed
24633

TT 24633 Profiles -> Membership Cards & Best Western Online Interface: Different
issues regarding profiles not being updated with BWR membership number after
successful BW enrollment. These fixes are available since version 8.9.6.3.

Profile Management
New Functionality/Feature
24464

TT 24464 Profiles: Ability to change the profile type has been implemented. Activating
the global setting 'Change Profile Type' under Setup->Configuration->Global
Setting->Profile->Profile 1 tab and the new user right 'Change Profile Type' under User
Rights->Customer Profiles enables the new functionality. On profile level the profile
needs to be selected and under Options->Change Profile Type the new type can be
selected, a search will be performed to check if conflicts with linked profiles of
reservations exist and the profile type can be changed accordingly. Statistics will be
affected as well (SHIS, SHIB, SHIE), except for cumulated statistics (SMAN). Please
note, that the functionality is not available for HCN and CRS.
97297
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S8 General
Configuration
Issues fixed
24676

TT 24676 Configuration->Setup: In some screens the department code numbers have
been displayed with decimals. In this version they are getting displayed properly again.
101051

CRS
Issues fixed
25279

TT 25279 Suite8->CRS: Error on CRS Monitor and Reservation came up after upgrade
of V8 Master. This has been fixed.
102029

Maintenance
New Functionality/Feature
22731

TT 22731 Maintenance->Copy: Ability to copy maintenance tasks has been
implemented with the following options
Custom: No of copies and the according due date can be entered.
Series: No. of series can be entered with the following options:
-Daily: with the ability to define on which day it should be copied, e.g. every 3rd day
-Weekly: with the option on which week and what day in that week, e.g. every 2nd
week on a Wednesday
-Monthly: with the option on which day on every month, e.g. every 2nd day of every
month or on which weekday of every month, e.g. every 2nd Monday of every 3rd
month
For all options the due date to start with has to be defined.
All information except resolve notes and date/time resolved fields will be copied.
Estimation minutes will be considered as well. If not configured for a maintenance type
then for custom copy it's null and for series it's startdate+1day. If a task is flagged as
'out of order' the copy functionality does not copy the OOO/OOS record for that
particular room. For more information please refer to Online Help.
90123

Miscellaneous
Issues fixed
24610

TT 24610 Grids->Export to Excel: data has not been exported properly. This has been
fixed.
99367

25241

TT 25241 Financial Accounts->Notes: Notes for profile have not been saved properly
when entering new financial account and notes for the profile.
101932

Night Audit
Issues fixed
25222

TT 25222 Night Audit in Best Western Version: Error 'Transaction is not started for
fillBestWesternLevelAValues' came up when running night audit and when Global
Setting "Night Audit Day Type calculation" was enabled. This has been fixed.
101805
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Reports
New Functionality/Feature
9

The following reports/htmls have been changed:
- >DiaryConference.htm/qry: cancelled events have been filtered (TT25205)
The following reports/html have been added:
- FCR_LEI_10110_BOOKINGS
- FCR_LEI_10111_BOOKINGS_FACILITY_GROUP
- FCR_LEI_10112_BOOKINGS_BY_GUEST_ALL
- FCR_LEI_10113_BOOKINGS_BY_GUEST_SINGLE
- FCR_LEI_10114_BOOKINGS_OFFER_GROUP
- FCR_LEI_10130_FACILITY_SCHEDULE
- FCR_LEI_10131_TREATMENTS_SCHEDULE

Users
New Functionality/Feature
5

TT 5 The following user rights have been added:
Profiles: Change Profile Type

Release Notes Oracle Hospitality Suite8 Version 8.9.6.10

Page 11 of 18

S8 KIOSK
Kiosk
New Functionality/Feature
24393

TT 24393 Suite8 & Kiosk Interface: Kiosk Interface was checking if any IFC was down
and if so it did not start. Therefore the field 'Interface' has been implemented under
Setup->Configuration->Software Interface->Suite8 Kiosk Interface to select the
relevant Interfaces to be checked.
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S8 Online Interface
Online Interface
Issues fixed
25170

25185

25223

25243

25255

TT 25170 Online Interface - SynXis mapper: when the SynXis mapper is installed
together with the Rate Tiger mapper and for some reason the 1-Way response
messages were not sent to Rate Tiger, also the 1-Way response messages for SynXis
were not properly sent.
This has been fixed and the SynXis response messages are processed now.
101612
TT 25185 Online Interface - Rate Tiger mapper: when Rate Tiger sent a reservation for
one room and two guest profiles, the reservation was created using the second profile
and the first profile was not linked at all.
This has been fixed. When a reservation with two profiles is send, the reservation is
now created with the first profile and the second profile is attached to the reservation
as multi-guest.
101519
TT 25223 Online Interface - Vertical Booking mapper: for reservations from Vertical
Booking that have different rate amounts on different days in the reservation message,
only the rate amount of the last day was considered and entered in the reservation in
Suite8.
This has been changed and each day of the reservation stay now has the correct rate
amount.
101666
TT 25243 Online Interface - Rate Tiger mapper: when uploading rate codes that are
linked to day types, the days of the week were marked wrong in the rate code
message.
This has been fixed.
101707
TT 25255 Online Interface SynXis / Rate Tiger mapper: when running a SynXis mapper
parallel to a Rate Tiger mapper, 2-Way response messages to SynXis were not send out
when messages for Rate Tiger still exist in the 2-Way response queue table.
This has been changed and the messages to SynXis are now processed properly.

Online Interface Best Western
New Functionality/Feature
24974

TT 24974 Setup->Configuration->Software Interfaces->Suite8
Online->IFC->Mapper->Options->Reservation->CRS Currency: to be used in case the
CRS currency is different to the defined currency in Suite8. The reservation rate will be
converted accordingly when uploading. This is available for all mappers that support
reservation upload.
100543

Issues fixed
25251

TT 25251 Online Interface - Best Western mapper: when performing a selling limit
resynchronization, OOS rooms deducted the availability figures, which is
not correct.
This has been fixed.
101921

Online Interface Trust Voyager
New Functionality/Feature
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Online Interface Trust Voyager
New Functionality/Feature
23736

TT 23736 Online Interface - Trust Voyager mapper: a new setting called 'Use
Alternative Res. Attributes' has been implemented on the Trust Voyager mapper
configuration screen on the reservation tab.
When this new setting is activated, the Market, Source and Channel codes from a Trust
Voyager reservation message are mapped like in the following example:
The Trust Voyager Source code (<reservationOriginatorCode>) is mapped to the Suite8
source code.
The Trust Voyager Market code (<marketSegmentCode>) is mapped to the Suite8
market code.
The Trust Voyager Channel code (<secondaryOriginatorCode>) is mapped to the Suite8
channel code.
The code conversion has to be configured accordingly.
When the setting is deactivated, the original Trust Voyager code mappings are used.
95572
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S8 OTA XML IFC
OTA XML Upload
Issues fixed
24980

25120

25121

TT 24980 Software Interfaces-> OTA XML Interface: when a room type was linked to
another room type in the conversion configuration, instead of availability for the main
room type, the availability for the linked room type was uploaded to the CRS.
This has been fixed and now only the main room type availability is uploaded.
101119
TT 25120 Software Interfaces - OTA XML Interface: when using a linked room type list
in OTA XML room type conversion and creating a reservation for any of the linked room
types in Suite8, the resulting availability message contained the linked room type code
instead of the main room type code. The main room type code is now properly sent.
101430
TT 25121 Software Interfaces - OTA XML Interface: when deleting an 'out of order'
room in Suite8, the resulting availability message for the CRS did not contain a room
type. The room type is now included in the availability message.
101431
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S8 POS 8
Suite8 POS
New Functionality/Feature
23587

24988

25147

TT 23587 Suite8 POS: Signature Capturing on Suite 8 POS Mobile has been
implemented. It contains all signatures taken with a payment for room charges.

TT 24988 Suite8 POS: It is now possible to log on to POS 8 via a MiFare Transponder.

TT 25147 POS mobile: The speed sending new orders from POS mobile has been
enhanced.

XML Interface
New Functionality/Feature
24517

TT 24517 POS8: Ability to enter a second URL to switch to Suite8 XML Interface in case
of no response from the first URL.
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S8 Reservation
Miscellaneous
Issues fixed
24973

TT 24973 HTML Room rack: When a reservation has been made with a foreign currency
rate code, then roomrack.html showed amount in foreign currency, but currency
symbol was local currency.
101077

Rate Management
Issues fixed
24587

Rate Management: If Global Setting 'Day type rates turn to manual on save
automatically' is active and a rate with promotion has been linked to day type schema,
the promotion discount of a reservation has been recalculated in the event, that the
day type has been changed and the room type of a reservation is changed upon check
in, even though the reservation rate room type is filled. This has been fixed.
99353

Reservation Groups
Issues fixed
22930

TT 22930 Groups->HTML->Group Total: the field 'Children' showed 0 for reservations
which had not been split, although the number of children/teenager/baby had been
entered.

91384
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S8 XML Interface
XML Interface
New Functionality/Feature
24908

25037

TT 24908 XML Interface: Ability to delete notes has been implemented. In previous
versions it was only possible to enter and update notes.

XML Interface & Cashiering->Billing: pdf format storage via XML Interface has been
implemented for guest checks. When selecting the according billing in Suite8 the pdf
gets listed under right mouse click->Guest Checks.
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